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Building an Editing Session 

Saw Basics 
To effectively work with SAW it is important to organize your work environment. There are 
numerous windows containing different information all related to the one common 
denominator, your session. Reading the following will hopefully guide you through a planned
step by step approach into a real SAW session. The goal is that once you have completed this 
session you will have achieved a completed production.

The project is going to be a promotional spot consisting of a music bed and vocal dialog 
track. Choose a workable piece of music. Workable means a music selection with an easy 
drum beat and preferably no vocals so we can edit the intros, chorus and breaks. Having a 
microphone available will allow you to be the vocal talent in this production. If you don’t 
have a mike use some other vocal audio source and try to use the vocal dialog script as an 
outline. 

First On The List Is Sampling Rates
The sampling rate is how many times your audio card will sample the incoming signal per 
second. Note that the more samples taken from the audio source the better the quality of 
sound. Depending on the audio card you have in your system your options may be 11KHz 
through 48KHz with 48KHz being the highest quality. Note also that the higher the sampling 
rate the more hard disk space is used. On the average, for every one minute of 16 bit stereo 
sound recorded at 44.1KHz, approximately 11MB of disk space is used. Choose whichever 
rate you desire for this production, taking into account your available hard disk space. Open 
the File Menu and select Record SoundFile. Name the soundfile Music1 because we’re going 
to record the music first. The .wav extension will be automatically added. 

Click on the Rate button until your desired rate appears. The Demo version of SAW talks to 
your soundcard by using the Windows MultiMedia Drivers. Therefore, you must use your 
soundcard’s mixer applet to select the record input source and adjust the record volume level. 
Each soundcard is different, so refer to your individual soundcard’s manual for instructions. 
Press the Record Ready button which turns the lights underneath the VU Meters green. Begin
playback from your music source. This can be CD, Radio, Television, Tape Deck, etc. The 
VU Meters should be responding at this time. If they are not, check to see if your inputs and 
outputs are connected correctly to and from the audio card and that your mixer is properly 
setup to record. You can place the mixer path and filename in the Options Menu Directory 
Path Setup and open the mixer applet directly from the VU Meter panel, if desired.



Set the levels in the VU Meters by controlling the incoming volume from your music source 
or your mixer applet. Leaving some headroom is a very good idea when working in the 
digital domain. Soundfiles recorded individually at optimum peak levels, when combined can
exceed the available headroom mathematically. Therefore clipping occurs. Clipping will 
sound like sharp pops in the speakers. This can be avoided by recording at lower values. 
Recording at lower values is not as much of a consideration when recording digitally because
we do not have the inherent tape hiss problem that is always a factor with analog recording. It
is suggested that the Record Margin register about 60% to 70%.

We Are Now Ready To Record
Cue the music to the start point and press the Record button in SAW. The illuminated green 
lights should now turn red. Let SAW run in record a second or two and then begin playback 
of your music. Record all the essential elements necessary to build our music bed; i.e. Intro, 
Chorus, Break, Ending. Stop recording by pressing the Stop button.  Press Exit /Save and this 
will return us to the main windows.

Now lets record the vocal dialog. Open the File Menu and select Record SoundFile. Name 
this soundfile Dialog1. The .wav extension will be automatically added. It is very important 
to remain with a consistent sampling rate. SAW can not play soundfiles recorded at different 
sampling rates properly in the same session. Set your levels similar to the settings of the 
music.

Following is a suggested script to use for the vocal dialog. Of course you’re the producer of 
this Promo Spot so feel free to make up your own script though it would be best to follow this
outline for the purpose of this project.. 

NEW ON THE MARKET. SOFTWARE AUDIO WORKSHOP. A POWERFUL MULTITRACK 
SOUND EDITOR WITH UNMATCHED SPEED AND EFFICIENCY. SAW IS FAST 
BECOMING THE HARD DISK EDITING CHOICE OF PROFESSIONALS WORLDWIDE.

Press the Record button letting SAW run a second or two and begin your speaking 
performance. Speak clearly with a well pronounced delivery. Try a number of different takes 
as SAW continues to record. Unlike linear editors there is no need to stop and begin again if 
you make a mistake. SAW is a non-linear editor that allows you to quickly and accurately find
the best points on a soundfile and build each performance. This is a powerful and innovative 
design that allows you to concentrate on recording and will thoroughly be explained later in 
this session. All you need to be sure of is that the dialog being recorded is to your satisfaction
and appears somewhere on the soundfile. When your recording is complete press Stop and 
press Exit /Save. 

We Now Have Our Material On The Hard Disk And We Can Get To Work Editing
Since the Dialog1.wav is the current soundfile we’ll begin here. Remember SAW’s innovative
design? This section will teach you about SAW’s non-linear power in the digital environment.

First lets listen to the entire soundfile. Press the Cue Strt button in the Full View window. 
Now press Play or click the right mouse button to start playback. The cursor will begin to 
scroll and the soundfile will play. As you listen notice where some of the better vocal takes 
are. Now return to the beginning of the soundfile by placing the cursor at the beginning of the
FullView window and pressing the left mouse button or press Cue Strt. Begin playback again 
using the right mouse button or the Play button. Note that you may jump live, while SAW is 



playing, to a new play position by just pointing and clicking the left mouse button in the 
FullView window. This can be of great help in finding your cue points rapidly. Stop playback 
near a quality take of NEW ON THE MARKET using the right mouse button or the Stop 
button. Click the Transfer button on the FullView window and the cursor position will 
transfer to the SoundFile View. As an alternative, clicking the cursor in the yellow time bar 
area on the FullView window will automatically transfer the cursor position to the SoundFile 
View.

In the SoundFile View move the cursor back near a visual cue of what you think will be the 
beginning of NEW. This is accomplished by either clicking or holding down the left mouse 
button and dragging. Use the right mouse button again to start and stop playback. Look and 
listen to the cue point. Notice the tracking cursor is separate from the positioned cursor. Stop 
playback and press the Zoom In button a couple of times. By visually seeing the audio 
transients and clicking the right mouse button to start/stop playback find the exact cue point 
of NEW. Zoom in more until you get into the sound/sample detail you prefer.

To achieve seamless edits, choose the beginning of a region by moving your cursor to the 
approximate position of your edit  and then depressing the Z key. SAW will find the nearest 
Zero Crossing edit point and move the cursor to it. Marking your edit points on Zero 
Crossing points will help create edits with no ticks or pops.  Now, press the Mrk Beg button, 
zoom out and commence playback.  Stop near the ending of MARKET. Click the mouse on 
the tracking cursor where you stopped and zoom in. Using the same method as before, find 
the out point for MARKET. Once found, press the Mrk End button. The marked area becomes 
highlighted. This is a method easily learned and is remarkably faster than the scrubbing 
routine on reel to reel tape decks.

Note: If you select Auto Zero Cross Marking from the Options Menu, SAW will  
automatically find the nearest Zero Crossing point when you press the Mrk Beg or Mrk End 
button.

In the Regions Menu, highlight Create New Region and type the name VOCAL 1. Click OK 
and the new region appears in the regions list. Zoom out and begin playback stopping near a 
quality take of SOFTWARE AUDIO WORKSHOP. Place the cursor near the beginning of 
SOFTWARE and use the same method as before to locate the exact beginning and ending of 
WORKSHOP. Remember, use the right mouse button as a play and stop trigger so your ears 
can hear what your eyes are seeing. From the Regions Menu select Create New Region and 
name this VOCAL 2. Now use this procedure again and again locating begin and ending 
points. Name these as individual regions building your regions list according to the sound 
takes below:

(VOCAL 1) NEW ON THE MARKET
(VOCAL 2) SOFTWARE AUDIO WORKSHOP
(VOCAL 3) A POWERFUL MULTITRACK SOUND EDITOR
(VOCAL 4) WITH UNMATCHED SPEED AND EFFICIENCY SAW IS FAST BECOMING THE 

HARD DISK EDITING CHOICE OF PROFESSIONALS WORLDWIDE
(VOCAL 5) THE HARD DISK EDITING CHOICE OF PROFESSIONALS
(VOCAL 6) IS
(VOCAL 7) SAW

Saving Your Work
Up until now the only saved information we have are the soundfiles. These were saved 
automatically because we named them before recording them and saved them when exiting 



the Record Panel. Now you have just created reference marks to these soundfiles and named 
them as regions, and soon will organize these regions to play in a sequence. To save this data 
SAW creates a separate file. This is called an EDL or Edit Decision List. EDL files are small 
in size, unlike the large soundfiles, and will actually contain all of the referencing and timing 
values of your production. This concept allows you to build multiple arrangements of your 
project referenced to the same soundfiles on your hard disk and access them quickly. To save 
the work you have just completed, normally you would open the File Menu and select Save 
EditList. This Demo Version of SAW, however, will not allow EDL file saving.

On With The Session
Now open the File Menu and select Open SoundFile. Choose Music1.wav. This is the music 
soundfile. Notice that even though Music1.wav is now the current soundfile you still have 
instant access to the Dialog1.wav file which your regions come from. To see how this works, 
double click on a region in the EditList View window with the left mouse button. The 
Dialog1.wav file will appear and automatically highlight the marked area the region 
references. To return to where we were you will now need to open the Music1.wav file again.

Apply the same methods used earlier when building the vocal dialog regions to build the 
following music selections. For this music bed, we need an Intro region, a Chorus region, and
an Ending region. Find a section of your music that has a nice beginning feel to it. The goal 
here is to try and build clean Mrk Beg’s and Mrk End’s within the rhythm of the music. Begin 
with a downbeat and Mrk Beg. Find a rhythmic value, 8 beats away, usually just before 
another upcoming downbeat and Mrk End. So if we Mrk Beg on a downbeat and Mrk End 
just before another upcoming downbeat we should theoretically be able to loop this region 
endlessly, though this may take some practice. Name this region INTRO. Use the same 
method to create a Chorus region. Then create an Ending region. Remember to zoom in and 
get the cursor right on the beat of the music.

Your regions list will display alphabetically and should look like this:
CHORUS, INTRO, ENDING, VOCAL 1, VOCAL 2, VOCAL 3, VOCAL 4, VOCAL 5, VOCAL 
6, VOCAL 7.

On To The Next Phase Of Production, Building And Splicing Together A Sequence 
Highlight the INTRO region from the EditList View window by clicking the left mouse 
button once. Press the Add button and INTRO becomes an entry on the Sequence side of the 
EditList View window. Add INTRO three times by pressing the Add button two more times. 
Now highlight the first INTRO entry on the Sequence side and press the space bar on the 
computer keyboard, or the right mouse button. The INTRO entry will play and splice to the 
next entry.

HOW DOES IT SOUND? If the INTRO entry needs some adjustment, just double click on 
the INTRO region on the Regions side of the EditList View using the left mouse button. The 
soundfile will come to focus and the highlighted area will reflect the INTRO region. Note the 
difference between region and entry. A region is a reference to a marked area in a soundfile. 
A region becomes an entry when it is entered into a sequence. Use the ctrl and the left or 
right arrow keys on the computer keyboard to jump to the Mrk Beg or Mrk End points in the 
soundfile. Reposition the cursor with the mouse or by using the arrow keys only. Adjust the 
in point or out point and Mrk Beg or Mrk End. Open the Regions Menu and select Update 
Region. The INTRO region is updated with the new marks.



Now try playing the sequence again. Once it meets with your approval highlight [End Of 
Sequence] on the Sequence side of the EditList View window. Now highlight the CHORUS 
on the Regions side of the EditList View window and press the Add button once. Your 
Sequence view should now have: INTRO, INTRO, INTRO, CHORUS. Place the cursor on the 
third INTRO entry and press the Preview button. The Preview button will preload just enough
audio buffers to play the splice from the INTRO entry into the CHORUS entry.

HOW DOES IT SOUND? Adjust the CHORUS entry using the same method as before with 
the INTRO region. Update the region. Add the ENDING region the same way, by highlighting
[End Of Sequence], highlighting the ENDING region and pressing the Add button.

Your Sequence View should now have:
INTRO, INTRO, INTRO, CHORUS, ENDING. 

Building the MultiTrack
Now you will see how SAW brings all the elements together. Open the Windows Menu and 
select the MultiTrack View. At first, Track 1 is the activated or hot track. The sequence entries
in the hot track will always be red and the other entries in the other tracks will be blue. The 
menu features will only effect the hot track.

The sequence now appears in both the Sequence side of the EditList View and on Track 1 of 
the MultiTrack. Now select Track 2 by clicking on the top button next to Track 2. Track 2 
now becomes the hot track. Notice there aren’t any entries on the Sequence side of the 
EditList View. This is because Track 2 is currently empty. Each track will show its sequence 
of entries when activated.

Highlight the VOCAL 1 region and press Add. VOCAL 1 will appear on Track 2 and in the 
Sequence side of the EditList View. Click and hold down the left mouse button on VOCAL 1 
in the MultiTrack while holding down the shift key on the computer keyboard. Drag and 
position VOCAL 1 under the splice point of INTRO 1 and INTRO 2. Now using SAW’s ability
to work in a non-linear fashion, highlight VOCAL 5 and this time click the cursor under 
INTRO 3 on Track 1 of the MultiTrack. Now when pressing the Add button, VOCAL 5 will 
automatically jump to the cursor position on the MultiTrack.

SAW’s MultiTrack capability allows for live combining of up to four stereo (8 tracks) of 
digital audio, on one stereo sound card. This powerful and unique design allows you to break 
away from the cut and paste routines of trying to mix all your soundfiles into one. Try 
playing the two tracks together to see if you like the timing of the vocal entries in relation to 
the music bed. Place the cursor in the gray area to the left of the entries on the MultiTrack by 
clicking the left mouse button. Using the right mouse button to start and stop, begin playback.

HOW DOES IT SOUND? Notice, SAW is mixing Track 1 and Track 2  together for you in 
real-time. This translates into unmatched versatility when building productions of this nature. 
Continue highlighting each vocal region with the next region being VOCAL 2. Place the 
cursor into a position beyond the previous entry on Track 2 of the MultiTrack and press Add. 
Continue this method in the order of VOCAL 6, VOCAL 3, VOCAL 4, VOCAL 7, and VOCAL 
2. Drag each entry into position by auditioning the tracks.

Your sequence should be as follows:
VOCAL  1, VOCAL  5, VOCAL  2, VOCAL  6, VOCAL  3, VOCAL  4, VOCAL  7, VOCAL  2.



The performance should flow like this:
New on the market, the hard disk editing choice of professionals. Software Audio Workshop is
a powerful multitrack sound editor. With unmatched speed and efficiency, SAW is fast 
becoming the hard disk editing choice of professionals worldwide. SAW. Software Audio 
Workshop.

If your music bed runs short, you can insert a music region on Track 1. Activate Track 1 and 
highlight the region of choice in the EditList View window on the Regions side. Highlight the
entry on the Sequence side of where you want the insert to be. Press Add and an insert occurs.
To delete a music entry from a sequence, highlight the entry of choice on the Sequence side 
of the EditList View and use the delete key on your computer keyboard. All following entries 
will move forward. If you want to delete an entry without disturbing the following entries use
the shift and delete keys.

WARNING: IF YOU DELETE A REGION ON THE REGIONS SIDE OF THE 
EDITLIST VIEW ANY SEQUENCE CONTAINING THAT REGION WILL ALSO BE 
ALTERED. 

Non-destructive mixing in the MultiTrack View
Open the Window Menu and select Mixer Window. Each fader will work the volume (mix) 
levels for each track. SAW does not process these mix changes to the soundfile. Instead the 
volume changes remain non-destructive because SAW is performing these changes in real 
time. This gives you the freedom to audition and change a mix without affecting the original 
soundfile.

Notice the yellow line running underneath the regions on each track. This is the volume line. 
When a volume change occurs it is referred to as a mix change. The yellow color represents 
no volume change to the actual volume that the soundfile was recorded at. A -db such as -3db
will change to a dark green and a +db such as +3db will change to a bright green. Place the 
cursor at the beginning of VOCAL 1 on the MultiTrack and grab the first fader on the Mixer 
window. Pull down the fader until -5 appears. Place the cursor at the end of VOCAL 1 and 
slide the fader back to 0. Now when playback occurs across VOCAL 1 the music on Track 1 
will drop -5db.

HOW DOES IT SOUND? If you want to change the mix, place the cursor somewhere 
before the mix change you want to alter and press NEXT on the Mixer window under the 
proper fader. The cursor will jump to the next mix change. Adjust your db settings on the 
Mixer. Use the same procedure for each crossing of VOCAL entries and music getting just the
right mix you’re looking for.

Now, lets put an ending fade to the Promo Spot. Place the cursor at the end of the music on 
the MultiTrack and pull fader 1 down to -70db on the Mixer. Look at the Current value in the 
Time View window and scroll the cursor on the MultiTrack until about 7 seconds have been 
subtracted. Make sure Track 1 is the hot track and open the Sequence Menu and select Fade 
To Next Mix Change. Select OK and SAW will draw a fade that is a 7 second fade out of the 
music.                                                                                                                           

To put a rising fade in the beginning of the music place the cursor at the beginning of the first
INTRO entry. Pull fader 1 down to -70db. Now place the cursor somewhere before the -5db 
mix change. Place the cursor on fader 1 and hold down the left mouse button while clicking 



the right mouse button. This will automatically reset the fader to zero. Now place the cursor 
back at the beginning of the music bed making sure that -70db is registered in the fader 1 
window. Open the Sequence Menu and select Fade To Next Mix Change and SAW will draw a
fade up to the next mix change.

In Closing
Try  playing the Promo spot from the beginning by placing the cursor in the gray area to the 
left of the entries on the MultiTrack and click the left mouse button. Click the right mouse 
button to start/stop playback. You may now continue to make any changes to your production
that you like, without even altering any of your original soundfiles.

You can now play your production directly to DAT or Cassette, or you can do an internal 
mixdown to one soundfile using the process called Paste Sequence.

SAW opens the door to powerful audio production with innovative design concepts uniquely 
packaged in one program. We hope you enjoy your exploration of SAW’s Non-Linear editing 
environment and we hope to see you as a registered SAW owner soon.

Thank you, and happy sessioning !


